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Quick Guide for Creating 
WCAG Compliant Documents 

Microsoft Word and Adobe Acrobat PDF 

By: Amanda Casby, Haley Hudson, and Leela Dixit 

DWR/DES Aquatic Ecology Section 

Updated: 6/30/2021 

This quick guide is intended to provide basic instruction on how to create Microsoft Word and 

Portable Document Format (PDF) documents that are compliant with W3C’s Web Content 

Accessibility Guidelines (WCAG), Levels A and AA, as required by the American with Disabilities 

Act, Section 508 of the federal Rehabilitation Act, and California state laws and policies. This 

guide can be used as a quick reference and is not intended to be completely comprehensive. 

The above references provide broader detail and background. 
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Document Setup 

To save time editing a document after it has been created, it is useful to set up the formatting 

of your document to be WCAG compliant before adding content. If you are using the Office of 

Water Quality and Estuarine Ecology (OWQEE) report template, it is already setup to be WCAG 

compliant. However, you can modify some of the suggested settings detailed below as long as 

you stay within the required parameters identified. The essential details to focus on are as 

follows: 

Font Type 

Font type must be sans-serif. Serifs are the extended features at the end of strokes, so sans-

serif lacks the extended features (Figure 1). Ensure that you have a Sans Serif font selected, 

such as Arial or Calibri, before you begin working. 

 
Figure 1: Example of serif (left) font and sans serif (right) font. 

Replace Option  

If you get to the end of creating a long document and realize you used an incorrect font 

style, it can be useful to use the “Replace” editing option within the Home tab. 

Instructions: In the “Find what” space you can select Format, Font, and the font you 

accidentally used. In the “Replace with” space you can select Format, Font, and the font 

you would like in the document. Choose the “Replace All” option to replace in the entire 

document (Figure 2). 

Note: If you are using a different font style for Headings, this process might change 

those fonts. Take caution and double check your document after using this technique. 
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Figure 2: Location in Word to replace font. 

Font Size 

Font size must be 12 or higher, 14 is preferred. To avoid using too small of font, you can use the 

pop-out font menu and select a WCAG compliant font type and size and click the “set as 

default” button. It is recommended you do this prior to adding content to your document. If 

you finish your document and need to change the font, you can use the replace option 

described above for changing font sizes but note that it may affect your heading styles. 

Colored Text 

If you choose to use colored text, be sure that it has high contrast. For example, do not use 

yellow text on a white background. Black or dark blue text is a better option. A color contrast 

analyzer is a good idea to reference if you need to use a lot of colored text for a project. 

Text Boxes 

Do not use text boxes. Use the font and paragraph settings to find creative ways to move 

around text if necessary but text boxes should never be used. 

Header/Footer 

The header and footer can be used; however, no essential information should be placed there. 

A screen reader will not read the header and footer so do not place essential information there 

that is not found elsewhere in the document. 

https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
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Styles 

The built-in styles formatting is essential to creating a well-organized and WCAG compliant 

document. Styles are used to create consistent formatting for headings and text throughout a 

document and can be used for navigating with a screen reader. The preset Styles settings on 

default Microsoft Word can be used; however, if you want to personalize your document you 

can add a new style or edit an existing one. If you would like to make changes, it is best to do so 

during document setup. Below are the basic steps: 

Instructions: 

Step 1. Select the Styles Dialog Box Launcher from the Home toolbar (Figure 3). This will bring 

up a pop-up menu. 

 
Figure 3: Location in Word to find the Styles Dialog Box Launcher. 

Step 2. Select the Manage Styles option to edit or create a new style. A pop-up menu called 

“Styles” will appear where you can then select the specific style you’d like to edit (example: 

Heading 1). After making the selection, you can then select the “Modify” option (Figure 4). 
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Figure 4: Location in Word to "Modify" a font style. 

Step 3. Make any changes you would like to the formatting such as font type, font size, and font 

color. At the conclusion of your selections, you then have the choice to either add these 

changes to the styles gallery, automatically update the document with the formatting choices 

(this is useful if you forget to update until halfway through working on a document), apply 

these format modifications only in this document, or use these format modifications to make a 

new template for future new documents (Figure 5). 
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Figure 5: Location in Word to modify style templates. 

Be sure that whatever changes you make to the Styles follow the guidance on font type, font 

size, and font color. Once you have setup Styles you are ready to start adding content to your 

document. Be sure to check your styles/headings as you add content. For more details on how 

to do that, reference the Check Headings section below. 

Formatting 

Having correct formatting within and between paragraphs is necessary for creating a WCAG 

compliant document as screen readers will read everything, including spaces. 

Instructions: Every punctuation must be followed by one space. Spacing should NOT be done by 

using “Tab” or “Enter”. After each paragraph or heading, use a single enter press to start a new 

paragraph and make sure there is similar spacing before and after each segment of text. To 

ensure this is correct, you can turn on “Show/Hide” to see the formatting of your document 

(Figure 6). 

 

Figure 6: Location in word to turn on "Show/Hide" for formatting. 
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Document Writing 

Images and Reading Order 

Images within a document need to be properly formatted so screen readers can read them in 

the correct order. To establish the proper reading order, images should be formatted using the 

“In line with text” option. 

Instructions: Insert the image into the document then right click on the image and select “size 

and position” from the menu. In the Layout menu, select the tab “Text Wrapping” and then 

choose “In line with text” (Figure 7). If the reading order is not properly established in Word, it 

can be fixed after the document has been converted into a PDF. This can be accomplished using 

Adobe Acrobat (Standard edition) or FoxIt Phantom PDF (Business edition) (See the Reading 

Order section below). 

 

Figure 7: Location in Word to find correct wrapping style for photos. 

Alt text 

Alt text is a description tagged to an image which is read by screen readers. Alt text should be 

added for all images and diagrams in a document unless the image is decorative. The alt text 
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should describe the meaning conveyed in the image in a few concise sentences or less. The alt 

text should not be a direct copy of the figure caption but rather provide additional information 

that the image is conveying. It’s useful to write alt text in a separate word document first (to 

make editing easier) then toward the end of the writing process when images are in their final 

form add it into your document. If possible, the original author of the image and document 

should write the alt text. For more information on what should be included in alt text refer to 

this Alt Text Resource. 

Instructions: To add alt text, right click on your image and click “edit alt text” in the drop-down 

menu. An alt text window will open on the right side of the screen. Enter your concise 

description in the white box. If the image does not provide any information and is just 

decorative, check the box “Mark as decorative” so that the screen reader will skip over this 

element (Figure 8). Examples of decorative images are logos and banners.

 

Figure 8: Location in Word to add Alt Text to photos. 

Hyperlinks  

Hyperlinks should be linked to displayed text rather than pasting the URL into the document. A 

screen reader will read each letter of a URL link so instead use a descriptive word or words to 

connect to the hyperlink. For example, instead of saying "click here for the IEP home page," the 

linked text could say, "for more information, visit the IEP home page." 

Note: Non-linked URLs can be used for documents that intend to be printed as a hard copy. 

Instructions: To insert a hyperlink, highlight the word(s) you want to display, then press Ctrl+K. 

When the “Insert Hyperlink” box appears, paste your URL in the “Address” box. Click “OK” 

(Figure 9).

http://www.w3.org/WAI/tutorials/images/complex/
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Figure 9: How to insert a hyperlink. 

Tables 

When inserting tables, make sure to specify the column header row so that the table can be 

read by a screen reader. 

Note: Screen readers in Word do not read tables or figures. You will need to use an external 

screen reader, such as NVDA. 

Instructions: Select your table then click on the “Design” tab in the upper menu. Check the box 

for “Header Row” on the left side (Figure 10). 

 

Figure 10: Location in Word to adjust column headers. 

Then highlight your header row in the table, and right click. Select “Table properties” in the 

drop-down menu. Then click on the “Row” tab on the top left. Under “Options” click the box 

“Repeat as header row at the top of each page”. Make sure “Allow row to break across pages” 

is unchecked. Then Click ”OK” (Figure 11). 
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Figure 11: Location in Word of final steps for creating tables. 

Note: Don’t split cells, merge cells, or have more than one header row. If you can tab smoothly 

through the table, a screen reader should have no problems with it. Avoid the use of tables if 

the information can be conveyed in other meaningful ways.  

For more information on tables, review this tables resource guide. 

Color 

Some people have difficulties differentiating between colors, so do not use color as the only 

source of conveying meaning in text, diagrams, and charts. Instead, incorporate text and 

patterns with color to convey meaning. See Figure 12 below, which shows a comparison of a 

graph that uses only color to convey meaning (left side) versus a graph that uses text, pattern, 

and color to convey meaning (right side). Also, to ensure that your figures have enough 

contrast, you can use this color contrast checker. 

 

Figure 12: Non-WCAG compliant graph (left), and WCAG compliant graph (right). 

http://blogs.wright.edu/learn/accessibility/word/tabs-tables-and-columns-in-microsoft-word/
https://webaim.org/resources/contrastchecker/
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Check Headings  

Headings are important for navigating a document when using a screen reader. You will want to 

check that your document headings are correct and organized as you create your document. 

Screen readers do not read the “Title” style, so you will want to make sure that the document 

title is styled as “Heading 1”. All other headings within the document should be styled as 

subheadings 2, 3, etc.  

Instructions: Under the “Home” Tab on the far right click the “Find” button in the “Editing” 

Section. A Navigation window will pop-up on the left side. Click on the “Headings” tab in the 

Navigation window (Figure 13). This will show you the organization of your document that you 

created using the styles formatting. Make sure that all the headings appear in the correct order 

(Heading 1 comes before Heading 2, and Heading 2 is before Heading 3, etc.). Screen reader 

users will use the headings to move to specific sections of the document. Correct formatting of 

headers will also ensure that the Table of Contents is formatted correctly.

 
Figure 13: Where to find the "Headings" tab in Word. 

Author and Title 

Your document must have embedded information about who the authors of the document are 

and what the title is. This info can be added in the “info” section of your document. 

Instructions: Under “File” of the document, look for “info” at the left of your screen, and insert 

the information for the document title and authors. (Figure 14) 
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Figure 14: Location in Word to add title and author. 

Microsoft Word Accessibility Check 

When your document is close to finalized, you can use the Word Accessibility Tracker to point 

out major issues. This checker may not find all accessibility issues but can be used to identify 

the most common issues.  

Instructions: To use the checker, click on the “Review” tab in the upper menu and then click on 

the “Check Accessibility” button. An Accessibility menu will appear on the right side of your 

screen and list potential accessibility errors (Figure 15). These errors can be a good starting 

place, but additional errors may still be present. 

 

Figure 15: Location of the accessibility checker in Word. 
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Transitioning from Microsoft Word  
to an Adobe Acrobat PDF  

After finalizing the document, there are additional steps you can take to ensure your document 

is accessible as a PDF in Adobe Acrobat. Start by opening the document as a PDF in Adobe 

Acrobat. 

Check Title and Author 

Check to see if your document has an assigned “Title” and “Author” under the “Properties” 

feature. 

Instructions: Click on “File” then click on “Properties” (Ctrl + D) and fill in the information under 

the “Description Tab”. The title should be the document title found at the top of the document 

rather than the file name (Figure 16). Make sure an author is identified as well. 

Note: This step must be done prior to converting your Word document into a PDF. If you do not 

see an assigned “Title” or “Author”, you must go back to your Word document and add it 

before conversion. 
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Figure 16: Location in Word for adding a title and author to the properties of your document. 

Accessibility Check in Adobe Acrobat 

Use the Accessibility Tool in Adobe to check for PDF accessibility issues. This checker is often 

more extensive and reliable than the Microsoft Word check but still may not identify all issues. 

For users of FoxIt Phantom, you can find more information on their accessibility tools online. 

Instructions: In the upper left corner, select the “Tools” tab then click on “Accessibility”. In the 

new bar on the right, click “Full Check” and proceed with the “Start Checking” button. Errors 

will appear on the left side panel (Figure 17). 

https://www.foxit.com/solution/accessibility/
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Figure 17: Where to run an accessibility check in Adobe Acrobat. 

Reading Order  

One common accessibility error that you may experience is with reading order. Adobe will label 

your document with numbered boxes which indicate the order in which the screen reader will 

read the document. This can be particularly important for documents containing multiple 

figures or columns. 

Instructions: To change the reading order using Adobe Acrobat, click on “Reading Order” on the 

right-side panel. Then, on the left-side panel, click on the “Z” symbol second from the bottom. 

Click on the number under “Order” that you want to change and drag to the correct position in 

the list (Figure 18). Here you can also check to make sure your figures have alt text by looking 

for a black box with your description next to the figure. 
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Figure 18: Where to adjust reading order in Adobe Acrobat. 

Tagging 

Tagging is another feature that helps to structure the document and allows the screen reader 

to easily move through the document. Thus, it is important to make sure that lists, headings, 

paragraphs, figures, and tables are tagged as such. 

Instructions: To change the “Structure type” of your tag, right click on the element you want to 

change in the left-side panel under “Order”. In this drop-down menu, click the “Tag as ….” 

corresponding to the structure of what you want to tag. Click “Show page content groups” and 

then select “Structure types” on the drop-down menu (Figure 19). This will allow you to see the 

structure of each tag and adjust if needed.  

Note: Make sure that your title is tagged as “Heading 1” since the screen reader does not 

recognize the Title tag. The first heading style to use within the document will be “Heading 2” 

and so on. You can also check to make sure your figures have alt text by looking for a black box 

with your description next to the figure. 
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Figure 19: Where to change structure type in Adobe Acrobat. 
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Quality Assurance and Quality Control Checklist  

This checklist was created to ensure that minimum accessibility standards have been 

incorporated into document development. When your document is complete, it is a good idea 

to go through this checklist or have another individual use it to review the document to identify 

any accessibility issues.  

It is recommended that you download a copy of any accessibility reports to include when 

uploading/submitting documents.  

Font 

 Style: Sans serif font? 

o For example, Arial, Verdana, or Calibri  

 Size: At least 12 points? 

o 14 is preferred. 

Color in Text or in Graphics 

 High contrast against the page? 

 Color not used alone to convey meaning? 

Images/Alternative Text 

 Alternative text included in all images? 

 Decorative images with alt text checked as decorative? 

o e.g., logos and borders 

 Alternative text properly describing the image? 

o If you don’t understand what an image is conveying, ask the author or someone else 

knowledgeable on the topic.  

o Alt text is usually added content to an already finalized document so technical 

accuracy and correct interpretation is very important. Take extra time to review the 

accuracy of text.  

 Alt text is different from the figure caption? 

o The reason for having alt text is to describe the purpose of the figure and/or describe 

the image. For example, if a figure is depicting growth over time, one could simply 

say "a graph showing growth over time," but a more useful alt text could say, "A 

graph showing growth over time, with a peak in growth in 2012." 

o If there are no additional details needed in the alt text compared to the figure 

caption, alt text should read “Figure #”.  
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 Image in line with text? 

o Images need to be inserted and formatted for reading order. Images should be 

inserted with the layout as “in line with text” so the screen reader can read the text 

in correct order. 

Tables 

 Is the header row specified? 

 Only one header row per table? 

 Any split, merged, or empty cells? 

o A quick self-check would be to try and "tab" through the table. If you can easily move 

through the table left to right without hitting any empty spaces, then the screen 

reader should be able to read the table. 

Hyperlinks 

 Are hyperlinks concealed in text? 

o Screen readers will read every character of a URL. Links should be descriptive. For 

example, instead of saying "click here for the IEP home page," the link could say, 

"visit the IEP home page for more information." 

o If the document will end up being printed as a hard copy, it is okay to include a non-

hyperlinked URL so that information is not lost. 

Formatting 

 Using one space after a period? 

o Screen readers read spaces, so there should only be one space after periods in 

sentences. 

 Are spaces added using tab or enter? 

o Using tab and enter is an effective way to make a document more visually pleasing, 

but screen readers read these as "spaces." Instead, it is recommended to use the 

paragraph settings to create spaces. 

 Headings Styles used? 

o The title should be “Heading 1”. The first heading in the document should be 

“Heading 2” and so on.  

o Screen readers can tab through headings so that the user can move more easily 

through sections of a paper. 

 Are there text boxes? 

o Text boxes are typically read out of order for screen readers. It is recommended that 

outside borders are used instead.  
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 Does the document have a Title and Author in the document properties? 

o The document title should correspond with the title at the top of the document 

rather than the file name.  

Tagging in PDF 

 Using Adobe Acrobat, are the styles lists, headings, paragraphs, figures, and tables 

tagged as such and in a logical reading order?  

Aesthetics 

 Does the document look aesthetically pleasing?  

o A WCAG compliant document is sure to create changes in the overall appearance of 

the document, but it still needs to look nice. Some documents (e.g., fact sheets) may 

require more work to make them look less plain.  

 Is the content conveyed clearly?  

Accessibility Check 

 Has the PDF undergone an accessibility check using the Accessibility Reader? 
o It is important to not rely on these built-in checkers. However, they may be used to 

identify issues that require remediation of your document. 

 Checked with Screen Reader? 
o All documents should be read with a screen reader. This will let you hear how the 

document is read and identify any flaws. 

o Screen readers in Word do not read tables and figures. It is best to use a screen 

reader outside of these applications, such as NVDA. 


